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Lesson 1
Introduction and Material Choice

When you complete this lesson, you will be able to:
Describe the relationship between Sustainability and SolidWorks;
Identify the principle components of the Sustainability Add-in;
Explain significance of Material choice and environmental impacts. 
1
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Using This Book
SolidWorks Sustainability An Introduction to Sustainable Design
helps you learn the principles of using Sustainability and Sustainability as integral 
parts of a creative and iterative design process.
For this project, You will “learn by doing” as you complete a structural analysis. 

What is SolidWorks Software?
SolidWorks is design automation software. In SolidWorks, you sketch ideas and 
experiment with different designs to create 3D models using the easy to learn 
Windows® graphical user interface. 
SolidWorks is used by students, designers, engineers and other professionals to 
produce single and complex parts, assemblies and drawings.

Prerequisites
Before you begin the SolidWorks Sustainability An Introduction to
Sustainable Design you should complete the following online tutorials that 
are integrated in the SolidWorks software: 

Lesson 1 - Parts-Set 1
Lesson 2 - Assemblies-Set 1
Designing for Sustainability-Set 2
Simulation - Static Analysis
Simulation - Thermal Analysis

You can access the online tutorials by clicking Help, SolidWorks Tutorials, All 
SolidWorks Tutorials (Set 1) and Simulation Tutorials by clicking Help, 
SolidWorks Simulation, Tutorials. The online tutorial resizes the SolidWorks 
window and runs beside it.
As an alternative, you can complete the following lessons from An Introduction to 
Engineering Design With SolidWorks:

Lesson 1: Using the Interface
Lesson 2: Basic Functionality
Lesson 3: The 40-Minute Running Start
Lesson 4: Assembly Basics
Lesson 6: Drawing Basics
Using This Book 2
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Conventions Used in This Book
This manual uses the following typographical conventions:

Convention Meaning

Bold Sans Serif SolidWorks commands and options appear in this style. 
For example, Insert, Boss means choose the Boss option 
from the Insert menu.

Typewriter Feature names and file names appear in this style. For 
example, Sketch1.

17 Do this step. The steps in the lessons are numbered in sans serif bold.
Conventions Used in This Book 3
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Sustainability Options
Here we will go through the Sustainability interface and different menus as well 
as define various terms used within the SolidWorks Add-In. There are four main 
menus, Material, Manufacturing, Transportation and Use, and Environmental 
Impact.
First, we will start SustainabilityXpress.

1 Start Sustainability.
Click Tools, Add-Ins, Check Sustainability.

Note: A Part or Assembly needs to be open to view Sustainability. When you first open 
the Add-In, everything should be black except for the regions.

Materials
In this option you can choose between different 
materials for the specific part using the drop down 
menus. You are also able to search for alternative 
materials using the Find Similar option. You can also 
assign a material of your choice to the part. 

Manufacturing (Parts)
The Manufacturing section includes Process and Use to define world locations. 

Process
In this option, there is a drop down menu labeled 
Process where the user can chose between multiple 
different production techniques to manufacture their 
part. There is also a world map. The world map is for 
the user to define where the part is going to be made. 
There are four different areas to choose from, North 
America, Europe, Asia, and Japan. 

Use
The second world map is used in this menu. Here you 
are able to chose where your product will be transported 
to after production. The further the distance between 
manufacturer and user the less environmentally friendly. 

Note: All the regions for Manufacturing and Use are the same.
Conventions Used in This Book 4
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Manufacturing and Transportation (Assemblies)
Within Assemblies the Sustainability interface changes slightly. 

Manufacturing (Assemblies)
The only difference from the manufacturing menu for a 
part is that it does not have a process drop down menu 
instead the user is only able to choose the Manufacturing 
Region.

Transportation and Use (Assemblies)
With in this menu the user is given the ability to chose the 
Primary Mode of Transportation (Train, Truck, 
Boat, or Plane). The user is also able to choose the Type
of Energy that will be used throughout the lifetime of the 
product. Like before in the Use menu for Parts the user is 
also able to choose the Region the that product will be 
used. 

Environmental Impact
This area includes four quantities: Carbon Footprint, Total Energy, Air 
Acidification, and Water Eutrophication. Each graph shows the user a graphic 
breakdown of Material Impact, Transportation and Use, Manufacturing, and 
End of Life. 

Carbon Footprint

A measure of carbon-dioxide and other greenhouse gas emissions 
such as methane (in CO2 equivalent units, CO2e) which contribute 
to an emissions, predominantly caused by burning fossil fuels. 
Global warming Potential (GWP) is also commonly referred to as a 
carbon footprint.
Conventions Used in This Book 5
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Energy Consumption

A measure of the non-renewable energy sources associated with the 
part’s life cycle in nits of mega joules (MJ). This impact includes 
not only the electricity or fuels used during the product’s life cycle, 
but also the upstream energy required to obtain and process these 
fuels, and the embodied energy of materials which would be 
released if burned. Energy Consumed is expressed as the net 
calorific value or energy demand from non-renewable resources (e.g. petroleum, 
natural gas, etc.). Efficiencies in energy conversion (e.g. power, heat, steam, etc.) 
are taken into account.

Air Acidification

Sulfur dioxide, nitrous oxides other acidic emissions to air cause an 
increase in the acidity of rain water, which in turn acidifies lakes 
and soil. These acids can make the land and water toxic for plants 
and aquatic life. Acid rain can also slowly dissolve man-made 
building materials such as concrete. This impact is typically 
measured in nits of either kg sulfur dioxide equivalent (SO2e), or 
moles H+ equivalent.

Water Eutrophication

When an over abundance of nutrients are added to a water 
ecosystem, eutrophication occurs. nitrogen and phosphorous from 
waste water and agricultural fertilizers causes an overabundance of 
algae to bloom, which then depletes the water of oxygen and results 
in the death of both plant and animal life. This impact is typically 
measured in either kg phosphate equivalent (PO4e) or kg nitrogen 
(N) equivalent.

Report 

On the very bottom of SustainabilityXpress, there are the Generate Report  
and Email Report buttons. By clicking generate report, SolidWorks automatically 
creates a Word document about the current analysis. This analysis can be on an 
individual material type and environmental impacts or it can be on a comparison 
of two different material types. The email report opens Microsoft Outlook for the 
user to send the word document to an email address.
Conventions Used in This Book 6
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Baseline 

To the right of the report buttons are the Set Baseline  and Import Baseline 
buttons. By clicking set baseline, SustainabilityXpress automatically takes the 
most recent material type and sets it as the material that every other material will 
be compared to. Otherwise, every time the user clicks on another material, 
SustainabilityXpress will automatically compare them and dynamically 
recalculate the Environmental Impacts. Also, if there is no difference between the 
current and previous settings and materials then all of the Environmental Impacts 
will automatically turn green. Then, by clicking import baseline, the user can 
import a saved SustainabilityXpress baseline from another part.

Color Coding

When Baseline is clicked, the environmental impacts turn colors to represent 
different states. 

Black represents the baseline material. 
Green indicates that the current material is more environmentally friendly 
than the baseline material. 
Red indicates that the current material is less environmentally friendly than 
the baseline material. 
Conventions Used in This Book 7
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Material Choice in Sustainable Design
Here we will decide which material is the correct material to use depending of the 
materials environmental impacts over its lifetime. In this example, imagine the 
analysis of a cup.

The lifetime of a cup
The material of a product significantly affects its lifetime. For example, a cup 
could be made from paper, plastic, or metal. Depending on what material we use 
will decide how many times the cup can be used. For this example we will assume 
if we made the cup out of paper (we will be using pine because there is no paper 
material choice within SolidWorks that is linked with Sustainability) it could be 
used only once, a cup made from plastic can be used 10 times, and a cup made 
from metal could be used 1000 times.
Conventions Used in This Book 8
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Environmental Impacts
With the SolidWorks model we have for a simple cup, we have created three 
different configurations, one for each material type. We activated Sustainability 
and kept the Manufacturing and Transportation and Use the same continents for 
all three configurations. 

Here are the Environmental Impacts for each material: 

From these we will use the Total Energy as a baseline to examine which material 
is the most Sustainable for its lifetime. The results were as follows:
Paper: 8.30E-3 MJ
Plastic: 2.51 MJ
Metal: 2.98 MJ

Paper (Pine)

Plastic (ABS)

Metal (Chrome Stainless Steel)
Conventions Used in This Book 9
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2 Sustainability Calculator. 
Now we need to see which material is the most environmentally friendly based on 
its lifetime. The Sustainability Calculator takes the values that we found for the 
Environmental Impacts (CO2, MJ, SO2, and PO4) and re calculates it into 
something that is easier for us to understand (example: miles driven in a car or 
hours watching tv). 
To start, we will open the Sustainability Calculator. 

3 Go to www.solidworks.com/sustainability/products/calculator/index.htm. 

4 Click Energy Consumption. 

5 Click hours of watching TV. 

Impact vs. Lifetime 
Here we will discuss whether the Lifetime of the material is more important than 
its Environmental Impacts.
Using the Sustainability Calculator we will use the three Energy values we got 
from SolidWorks Sustainability and calculate which material is the best for the 
environment according to its lifetime. 
In order to do this we need to use the Lifetime values we discussed earlier. Instead 
of using the number of times each cup can be used we will use the number of cups 
that need to be made to equal one Metal cup. This means 1000 paper cups and 10 
plastic cups need to be made to equal one Metal cup. 
Conventions Used in This Book 10
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1 Sustainability calculator. 
Now, go back to the Sustainability Calculator and find the Current Design box. 

2 Enter numbers. 
Enter the numbers given for the Values and Quantities and click Calculate.

Note: You are only able to enter one set two sets of values. It would be easier to open 
three se per ate windows and compare the outcomes.

Name: Paper

Value: 8.30E-3
Quantity: 1000

Name: Plastic 
Value: 2.51
Quantity: 10

Name: Metal 
Value: 2.98
Quantity: 1

The Sustainability Calculator will calculate how many Hours of Watching TV is 
equivalent to produce these cups. You should get:
Paper: 2 Hours
Plastic: 6 Hours
Metal: 1 Hour

3 Material Decision. 
When comparing materials according to their lifetimes and environmental impacts 
it is wise to chose the material that effects the environment the least compared to 
how long its lifetime is. In this case, it is wise to chose the Metal Cup. The Metal 
Cup can be used the longest and when compared to the Paper and Plastic Cups it 
the least harmful to the Environment based on the cups Energy Consumption.
Conventions Used in This Book 11
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Lesson 2
Sustainability and Simulation

When you complete this lesson, you will be able to:
Add-In Simulation;
Activate Sustainability;
Mate Parts in an Assembly;
Create Static Studies;
Create a Thermal Study;
Edit individual Parts;
Evaluate Sustainability throughout Redesign.
12
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Using Simulation
SolidWorks Simulation lets you test products for defects before they’re 
built, helping prevent errors early in the design process. It's powerful 
enough for trained FEA analysts, yet easy enough for product designers. 
SolidWorks Simulation can even help you optimize your designs for 
maximum performance and savings.
13
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How to Activate Simulation with Sustainability
This section will show you how to activate SolidWorks Simulation and 
Sustainability.

Activating Simulation and Sustainability
1 Open Assembly.

Open Mug.

2 Activating the Add-In. 
Click Tools, Add-Ins. 
Click both checkmarks of SolidWorks 
Simulation as shown. 

Note: By selecting the check mark to the right of 
SolidWorks Simulation you are telling 
SolidWorks to activate SolidWorks 
Simulation every time you open SolidWorks.

3 Open sustainability.
Click the Evaluate tab on the top left of the 
screen. 
Select the Sustainability icon. 
A Life Cycle Assessment (LCA) window will 
appear. Click Continue.

4 Pin sustainability.
Click the pin in the top right corner so it looks like 
This docks the Sustainability Task Pane so it is always on the screen.

5 Sustainability for original design.
Once Sustainability is open it will automatically calculate the Environmental 
Impacts for the assembly.
14
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Note: If parts of the assembly do not have assigned materials to them, then 
Sustainability will prompt the user to select a material for the part or to exclude 
the part when calculating the Environmental Impacts.

Within the Sustainability menu under Transportation and Use select Boat  
under Primary Mode of Transportation.
Under Type of Energy leave it set to none.

Note: After each change made in the Sustainability Menu the Environmental Impacts 
will automatically update.

6 BaseLine. 

Click the Set Baseline . 
By setting the baseline, every time you make a change to the assembly and/or a 
change the Sustainability Menu the Environmental Impacts will update and 
compare the new Impacts to the Baseline we set.
15
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Mating Assembly
Here we will mate the base and Metal Outside to the rest of the mug.

Remating Metal Outside
1 Suppress Cover. 

Before starting we will suppress the Cover. 
Within our redesign we will not be altering the 
Cover.
Right-click Cover in the FeatureManager Design Tree.
Select the Suppress.

Note: By suppressing the part it fully takes the part out of the assembly. If any 
simulation is run the Cover will not be included in the mesh and if sustainability 
is run it will not be included in the environmental impacts.

2 Move Metal Shell.
Click and drag Metal_Outside to the left slightly as shown.

Note: By dragging it to the left we will be making it easier for us to see the mates we are 
selecting.
16
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3 Mate Metal_Outside and Plastic_Inside. 
Select the Assembly tab at the top left 
of the screen.
Click Mate.
Expand the Design Tree.

Now expand both Plastic_Inside 
and Metal_Outside.

Click Front Plane in both 
Plastic_Inside and 
Metal_Outside.

Click  on the tool bar that appears.

.

17
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Select the outside circle of the Plastic_Inside and the inside circle of the 
Metal_Outside.

Click  on the tool bar that appears.
You have successfully mated the Metal_ Outside and the Inside_Plastic
together.
Click Save.
18
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Analysis of Insulation
Here we will present why we chose to use a plastic inside and Metal Outside.

What makes good Thermal Insulator?
The term thermal insulation can refer to materials used to reduce the rate of heat 
transfer, or the methods and processes used to reduce heat transfer. Heat energy 
can be transferred by conduction, convection, radiation or by actual movement of 
material from one location to another. Thermal insulation is the method of 
preventing heat from escaping a container or from entering the container. 
Insulators are used to minimize that transfer of heat energy. In home insulation, 
the R-value is an indication of how well a material insulates. The flow of heat can 
be reduced by addressing one or more of these mechanisms and is dependent on 
the physical properties of the material employed to do this. 

Plastic
Plastic is a good thermal insulator, it 
minimizes the transfer of heat very 
well as show.
Also, plastic is significantly better for 
the environment than metal is.

Note: During this Tutorial we will not 
assume that this part will be recycled. 
We are basing our redesign on the 
calculated Environmental Impacts 
within SolidWorks.
19
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Metal
Metal has some opposite qualities to 
plastic. Heat is transferred through 
metal very easily as shown. 
Metal is not very environmentally 
friendly according to the 
Environmental Impacts within 
SolidWorks.
On the other hand, because metal has 
a high thermal conductivity it is good 
for spreading out the heat.
Also, metal is cheaper than strong 
plastics like ABS and has a nicer 
finish.

Plastic and Metal
The mug will consist of an outer layer and an inner layer. Because plastic is such a 
good insulator, plastic will be used as the inner layer for the mug as well as the 
handle. This way, the heat will be kept in with the plastic and the heat that does 
pass through the plastic will be distributed throughout the metal because metal has 
such a high thermal conductivity.
20
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Static Simulation
Here we will start our redesigning process. We will perform two se per ate Static 
Simulations. One will be for the outside walls of Metal_Outside and the other 
will be for the Handle. 

Static Study 1
1 Create Study.

Click the Simulation tab.
Select the down arrow under Study Advisor.
Select New Study.
First name the analysis Force 1.

Under Type select Static and Click .
2 Fixtures. 

Within the Static Study Design Tree right-click 
Fixtures and Select Fixed Geometry.
Change the view to Bottom by pressing the 
SpaceBar.
A dialog box will appear. double-click *Bottom.
Select the large inner face as shown.

Click .
21
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3 External Loads.
Press space bar and double-click Isometric.
Right-click External Load in the Static Study Design Tree.
Select Force as shown. 
Select the 2 round faces of the Metal_Outside.

Change the Force Value to 400 N.

Click 
22
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4 Running Simulation.
Right click Mesh and Select Mesh and Run.
Two dialog boxes will appear. One will Mesh the 
assembly and the other will Run the Static Study.
23
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5 Factor of Safety. 
Right-click Results. Select Define 
Factor Of Safety Plot. Leave all settings 
the same and click . A simulation box 
will appear click OK.

In the top left corner of the screen SolidWorks tells us the Factor of Safety is 
4.4e+002 or 440.
Click Save.
24
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Static Study 2
Now we will run a similar Static Study with the same amount of Force on the 
Handle to see what the Factor of Safety is.

1 Create Study. 
Click the Simulation tab if not already displaying it.
Select the down arrow under Study Advisor.
Select New Study.
First name the analysis Force 2.

Under Type select Static and Click .

2 Fixtures. 
Within the Static Study Design Tree right-click 
Fixtures and Select Fixed Geometry. 
Press the SpaceBar. Double-click Handle Fixture.

Select the inner face of the handle. 

Click .
25
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3 External Loads. 
Right-click External Load in the Static Study 
Design Tree. 
Select Force. Press space bar. 
Double-click Top. 
Select the inner bottom surface of the Plastic_Inside.

Change the Force Value to 400 N.

Click 
26
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4 Running Simulation. 
Press the Space Bar. 

Double-click Isometric. Right-click Mesh. Select 
Mesh and Run. A Linear Static dialog box will 
appear click Yes.
27
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5 Factor of safety. 
Right-click Results. Select Define 
Factor Of Safety Plot. Leave all settings 
the same and click . A simulation box 
will appear click OK.

In the top left corner of the screen SolidWorks tells us the Factor of Safety is 4.
Click Save.
28
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6 Design Evaluation. 
After completing the both Static Studies, Force 1 to show the concept of 
grasping the Mug and Force 2 simulating holding the handle with a substance 
inside, it is obvious that the handle is much weaker.Study for Force 1 showed a 
Factor of Safety of 430 and Force 2 showed a Factor of Safety of 4. For the 
concept of redesign, we will delete the handle from the Assembly. This will better 
the Environmental Impacts because there will be less material.

7 Deleting Handle. 
Because the Handle is a se per ate part, all we have to do is delete it from the 
assembly.
Select the Model tab in the bottom left hand corner of the screen. 

Right-click (-)Handle<1>.
Select Delete. 
Immediately after deleting the Handle, 
Sustainability updates the Environmental 
Impacts. Notice that all four of the Impacts 
show Green bars and all the numbers are 
less than the set baseline. 
29
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Thermal Study
Here we will create a thermal analysis that will show us if we are able to remove 
more material so that it is still suitable to hold.

1 Creating a Thermal Study. 
Once again Select the Simulation Tab and create a New Study.
Name this Study Convection and select Thermal.

Click .

From here we will be creating convection between the multiple surfaces to show 
us the outside temperature of the mug. 
We will assume that the fluid inside the mug is water (example tea) at a 
temperature of 80 degrees celsius. We will also assume the air temperature 
surrounding the mug is at 25 degrees celsius. 
Along with temperature, a convection coefficient is needed to calculate the 
convection through the materials of the mug. For the air we will use a convection 
coefficient of 10W/(m^2xK) and for the water we will use 500 W/(m^2xK). W 
stands for Watts, m stands for meters, and K stands for Kelvin.
30
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2 Thermal Loads 1. 
Right-click Thermal Loads. Select Convection.
The first convection we will create will be the convection of air on the mug. This 
convection will be on the majority of the surfaces on the mug.
Select all the exterior surfaces except the lower inner surface and inner bottom 
surface.
Press Space Bar. Double-click Base Surfaces to select the Base Surface and 
Base Fillet.

Next type 10 W/(m^2xK) for the convection coefficient and 298 (25+273) Kelvin 
for the ambient temperature.

Click 
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3 Thermal Load 2. 
Right-click Thermal Loads. Select Convection. Press Space Bar. Double-click 
Inside Surfaces.

This time only select the inner lower surface and the inner bottom.

Next set the Convection Coefficient to 500 W/(m^2xK) and the ambient 
temperature to 353 (80+273) Kelvin.

Click .
4 Running Simulation. 

Like in the Force analysis right-click Mesh.
Select Mesh and Run.
Two dialog boxes will appear again.
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5 Results. 
After the analysis has run it is not easy to see the temperature difference from the 
inside of the mug to the outside. If we take a section clipping of the mug we will 
be able to better see the temperature gradient. Right-click Thermal1 in Results. 
Select Section Clipping. Click . Now we can see the temperature gradient 
through the walls of the mug. If we create a probe for the inner and outer surface 
of the mug we can see the temperature values.

6 Probe. 
Press Space Bar. Double-click Front. Right-click Thermal1. Select Probe. Now 
click at two points relatively close to the ones shown.

7 Design Evaluation.
If we take a look at the temperature gradient we can see that it does not change 
much the middle of the wall to the outside surface. This tells us that we could 
decrease the thickness of the wall and still have a similar outside temperature.
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Wall and Base Redesign
Here we will redesign the mug with thinner walls. In order to do this we will need 
to open the individual parts and alter the features. Once this is done we will have 
to remate them.

1 Edit Outside Wall. 
Select the Model tab on the Bottom Left corner of the screen.
Right-click Metal_Outside<1> in the FeatureManager Design Tree. 
Select Open Part.
SolidWorks will open a new window for this 
part.

2 Edit Revolve Feature. 
Because the Metal_Outside part is created from a Revolve feature we will 
decrease the thickness of the revolve. 
Right Click on Revolve- Thin1 in the FeatureManager Design Tree. 
Select Edit Feature.

Within Thin Feature add “/2” after 3.226mm. 
Click .

By adding “/2” SolidWorks divides the thickness by 2.
Save and Close the part.
A dialogue box will appear asking if you would like to 
rebuild the assembly. 
Click Yes.
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Redesign of Base
Here we will be redesigning the base of the Mug. After redesigning the Metal
Outside we will have to also redesign the plastic Base. Because we made the 
Metal Outside thinner we will have to make the Base smaller as well.

1 New Dimensions. 
Right-click Base<1> in the FeatureManager Design Tree. 

Select Open Part. 
Expand Revolve1. 
Double-click Sketch1.

Double-click the 68.510mm Dimension. Change the Diameter to 65.28mm. Click 
.

2 Exit sketch. 

Exit the sketch by clicking . Save and close the part. A dialogue box will 
appear asking if you would like to rebuild the assembly. Click Yes.
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Simulation of Redesign
Here we will re run the two simulations created before to see if the design is still 
acceptable.

1 Rerun Static Study.
Select the Force 1.

Press Space Bar.

Double-click Isometric.

SolidWorks will update the Fixtures and External Loads of the redesign.
Right-click Mesh and Select Mesh and Run.
Right-click Results.

Select Define Factor Of Safety Plot...

Click .
The Factor Of Safety Plot shows that the assembly is still very safe with a Factor 
Of Safety of 2.1e+002 or 210.

2 Rerun Thermal Study.
Even though the Static Study showed good results we still need to run the Thermal 
Study to make sure that the outside surface it not too hot.
Click the Convection tab at the bottom of the screen.
SolidWorks once again will update the Simulation for the redesign.
Right-click Mesh and Select Mesh and Run.
Press SpaceBar.
Double-click Front.
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3 Probe. 
Right-click Thermal1 in Results.
Select Probe.
Select two points as shown. 

Previously the outside temperature was at about 338 Kelvin or 65 degrees Celsius. 
Now the outside temperature is at about 341 Kelvin or 68 degrees celsius.
The temperature only increased about three degrees Celsius after decreasing the 
Metal Outside thickness by half.
This is a very minimal increase for the amount of material we saved. This will be 
our Final Design.
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Looking at Sustainability
Here we will compare the sustainability of the original design with the that of the 
final design, along with two alternative designs.

Throughout the entire tutorial the environmental impacts have been decreasing.

Overall all the Environmental Impacts have decreased by about 50%.

Original Environmental Impacts Redesign Environmental Impacts

Carbon: 7.11g of CO2 Carbon: 3.78g of CO2

Energy: 87.03MJ Energy: 47.72MJ

Air: 0.04g of SO2 Air: 0.02g of SO2

Water: 0.02g of PO4 Water: 0.00962g of PO4
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Conclusion
In the begining of the design we had a bulky mug that was far from being 
environmentally friendly. SolidWorks allowed us to conduct Force and Thermal 
Simulation which allowed us to rid the mug of excess features as well decrease 
material use while keeping relatively similar insulation.
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